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Belajar	photoshop	cs5	pdf

Belajar	dasar	photoshop	cs5.	Belajar	edit	foto	dengan	photoshop	cs5.	Belajar	photoshop	cs5	untuk	pemula.	Belajar	photoshop	cs5	pemula.	Belajar	photoshop	cs5	pdf.	Belajar	photoshop	cs5	untuk	pemula	pdf.	Cara	belajar	photoshop	cs5	bagi	pemula.	Cara	belajar	photoshop	cs5.

Free	Transform	tool	memungkinkan	Anda	mengukur,	memutar,	memindahkan,	dan	membalik	elemen	apa	pun	di	layer	atau	layer	pilihan	Anda.	Photoshop	is	available	for	both	Windows	and	Mac	computers.	Lightroom	Classic	is	no	longer	available	as	a	stand-alone	product,	but	it	is	included	in	the	Adobe	Creative	Cloud	Photography	plan.	Setelah	Anda
menentukan	area	untuk	menyalin,	gunakan	bilah	menu	di	bagian	atas	dan	klik	"Edit">	"Copy	Merged."	Ini	akan	menyalin	seluruh	grafik	sehingga	Anda	dapat	menempelkannya	sebagai	layernya	sendiri.	Lightroom	currently	has	two	flavors:	Adobe	Photoshop	Lightroom	Classic,	and	Lightroom.	Anda	dapat	memilih	warna,	ukuran,	goresan,	gaya	font,	dan
berbagai	opsi	lain	untuk	mengubahnya.	Setiap	kali	Anda	membuat	kotak	teks,	Photoshop	akan	menghasilkan	layer	untuk	itu.	Pertama,	pilih	layer	yang	Anda	inginkan	untuk	menerapkan	opsi	dan	efek	pencampuran	Anda.	Alat	teks	berfungsi	seperti	alat	teks	lain	yang	Anda	gunakan.	It	was	developed	in	1988	and	has	since	become	a	mainstay	for	users
who	want	to	edit	existing	photos	or	even	create	their	own	images	and	graphics.	Photoshop	is	often	referred	to	as	Photoshop	CC	because,	since	2017,	Photoshop	has	been	available	to	purchase	only	via	a	Creative	Cloud	subscription.	Dari	sana,	Anda	memiliki	opsi	untuk	memilih	"Solid	Color,"	"Gradient,"	atau	"Pattern."	Pertama,	pilih	layer	yang	ingin
Anda	isi	dengan	warna	solid.	Anda	juga	dapat	mengklik	dua	kali	layer	apa	saja	untuk	memunculkan	opsi	untuk	layer	tertentu.	Adobe	Photoshop	Lightroom	Classic	is	the	renamed	version	of	the	traditional	desktop	Lightroom.	Lightroom	is	a	cloud-based	photo	service	that	works	across	desktop,	mobile,	and	web.	Anda	dapat	menemukan	gambaran	umum
langkah-langkah	di	bawah	ini.	Atau	subscribe	channel	Youtube	saya	Channel	Youtube	Dafi	Deff	dan	add	saya	di	lingkaran	Google+	Dafi	Deff.	It	was	created	for	consumers	who	are	just	getting	started	with	photo	editing	and	want	an	easy	way	to	organize,	edit,	create,	and	share	their	photos.	Unlike	Photoshop	CC,	Elements	is	available	as	a	one-time
software	purchase	rather	than	a	subscription,	with	a	$99.99	price	tag.	Apa	Kegunaannya:	Zoom	Tool	memungkinkan	Anda	memperbesar	area	dan	mengecilkan	area	tertentu	dari	suatu	gambar.	Di	Mana	Letaknya:	Bilah	alat	di	sebelah	kiri.	Adobe	Photoshop	uses	the	PSD	file	extension	for	all	its	files.	Apa	Kegunaannya:	Alat	Warna	dan	Swatch
memungkinkan	Anda	menggunakan,	memodifikasi,	menyalin,	dan	menyimpan	warna	kustom	untuk	konten	Anda.	Pilih	opsi	zoom	dari	menu	"View"	(seperti	yang	ditunjukkan	di	atas).	Jadi,	jika	saya	ingin	memotong	atau	menyalin	sepotong	Layer	4,	Layer	4	harus	disorot	pada	bilah	alat	Lapisan	saya.	Saya	suka	berpikir	tentang	layer	sebagai	lembaran
kaca	yang	ditumpuk	di	atas	satu	sama	lain	yang	akan	Anda	gunakan	untuk	membuat	produk	akhir.	Apa	Kegunaannya:	Penghapus	Dasar	atau	Eraser	Tool	berfungsi	sangat	mirip	dengan	alat	kuas	atau	brush	tool.	Saya	tahu	ini	adalah	alat	dasar,	tetapi	Anda	akan	menemukan	diri	Anda	menggunakan	ini	sesering	alat	lain	apa	pun	di	Photoshop,	terutama
ketika	Anda	telah	menyelesaikan	grafik	dan	perlu	membersihkan	sebagian	ruang	kosong	di	tepinya.	Pertama,	pilih	layer	atau	grup	di	panel	Layer.	Move	Tool	berfungsi	pada	setiap	lapisan,	dan	pada	grafik	secara	keseluruhan	-	jika	(ingat	cara	melakukan	ini?),	Anda	menyorot	semua	layer	Anda.	Saat	menggunakan	brush,	saya	selalu	menyarankan	untuk
menambahkan	lapisan	baru	agar	Anda	tidak	melukis	di	atas	elemen	lainnya.	It's	also	possible	to	add	text	to	images.		Thanks	for	letting	us	know!	Tell	us	why!	Berikut	ini	saya	mencoba	memberikan	panduan	dan	tutorial	tentang	cara	menggunakan	Photoshop,	baik	itu	cara	menggunakan	Photoshop	CS3,	cara	menggunakan	Photoshop	CS4,	cara
menggunakan	Photoshop	CS5,	cara	menggunakan	Photoshop	CS6,	dan	cara	menggunakan	Photoshop	CC	Photoshop	adalah	perangkat	lunak	edit	foto	dan	desain	yang	sangat	hebat	dengan	banyak	hal	yang	bisa	dilakukan,	termasuk	banyak	alat	yang	kadang-kadang	tampak	luar	biasa.	Buka	Color	Picker	dengan	mengklik	dua	kali	pada	kotak	bagian	atas
baik	di	modul	Warna,	atau	di	menu	di	sebelah	kiri.	(Lihat	Move	Tool	di	bagian	berikutnya	dari	posting	ini	jika	Anda	memerlukan	bantuan	lebih	lanjut	tentang	ini.)Kiat	Pro:	Satu	trik	yang	benar-benar	bagus	yang	dapat	Anda	lakukan	dengan	"Free	Transform"	adalah	dengan	menumpangkan	tangkapan	layar	PDF	untuk	membuat	gambar	yang	tampak	3D,
seperti	yang	ada	di	bawah	ini.	Untuk	memilih	gradien	yang	berbeda	dari	yang	ditawarkan	secara	default,	klik	tanda	panah	di	sisi	kanan	dari	gradien	default	untuk	membuka	Gradient	Editor,	ditunjukkan	di	bawah	ini:	Apa	Kegunaannya:	Alat	kecil	yang	berguna	ini	memungkinkan	Anda	mengekstrak	dan	menggunakan	warna	apa	pun	dari	gambar	apa
pun	di	Photoshop.	There	are	more	than	20	desktop	and	mobile	apps	in	the	Creative	Cloud	collection,	so	the	more	apps	you	have	in	your	subscription,	the	more	it	will	cost.	Apa	Kegunaannya:	Alat	Teks	memungkinkan	Anda	menambahkan	font	kustom	ke	database	Anda,	dan	memberi	Anda	akses	ke	pengaturan	font	tingkat	lanjut	yang	memberi	teks



Anda	gaya	yang	serius.	Photoshop	memulai	dengan	pilihan	brush	bagus	yang	dapat	Anda	gunakan	untuk	membersihkan	grafik	dan	membuat	beberapa	efek	visual	dasar.	Adobe	offers	a	30-day	free	trial	of	Elements	so	you	can	test	out	the	software's	functionality.	Kemudian,	buka	opsi	pencampuran	Anda	dan	pilih	opsi	yang	ingin	Anda	terapkan.	Pilih
ikon	yang	ditunjukkan	pada	tangkapan	layar	dari	bilah	menu	samping,	dan	seret	kotak	di	atas	area	yang	ingin	Anda	potong.	Selanjutnya,	buka	tab	untuk	proyek	Anda	saat	ini	dan	tempelkan	sebagai	layer	baru.	Follow	saya	di	Twitter	@dafideff	dan	Instagram	@dafideff.	Tahan	tombol	SHIFT	sambil	mengubah	untuk	mempertahankan	proporsi	elemen
Anda.	Background	Eraser	menggunakan	perbedaan	warna	untuk	membantu	Anda	menghapus	area	latar	belakang	yang	tidak	diinginkan	dari	gambar	Anda.	Dengan	sedikit	bantuan,	Anda	dapat	dengan	mudah	mengajarkan	diri	Anda	bagaimana	menggunakannya	untuk	menciptakan	grafis	yang	menarik	dan	indah.	Pengaturan	ini	memungkinkan	Anda
mengubah	ukuran	brush,	opasitas,	flow,	dan	sebagainya.	Anda	juga	dapat	memilih	contoh	warna	berdasarkan	nilai	RGB	atau	CMYK.	(More	on	Lightroom	below.)	Adobe	offers	a	seven-day	free	trial	of	Photoshop	as	part	of	one	of	its	Creative	Cloud	subscription	plans,	so	you	can	get	a	feel	for	the	software	and	see	if	it's	right	for	you.	Photoshop	employs	a
layer-based	editing	system	that	lets	you	create	and	alter	images	with	many	overlays.	Apa	Kegunaannya:	Layer	dapat	digunakan	untuk	gambar,	teks,	sapuan	kuas,	warna	latar	belakang,	pola,	dan	filter.	Jangan	khawatir	tentang	memilih	warna	yang	Anda	inginkan	saat	itu	juga	-	cukup	beri	nama	layer	dan	tekan	"OK."	Selanjutnya,	jendela	"Gradient	Fill"
akan	muncul.	Kemudian,	dari	bilah	menu	atas,	pilih	Layer	>	New	Fill	Layer	>	Pattern.	Pertama,	sorot	area	pilihan	Anda.	Meskipun	ini	mungkin	tampak	seperti	elemen	yang	cukup	jelas,	ia	sebenarnya	memiliki	fitur	canggih	yang	akan	membuat	konten	visual	Anda	tetap	hidup	dan	menyatukan	skema	warna	Anda.	Apa	Kegunaannya:	Move	Tool	adalah
alat	yang	cukup	mendasar	yang	memungkinkan	Anda	untuk	memindahkan	elemen-elemen	individual	dari	grafik	Anda.	Layer	yang	dipilih	disorot	dengan	warna	biru.	Ya,	saya	mengerti	ini	secara	teknis	hanya	penghapus,	tetapi	Anda	tidak	pernah	menggunakan	penghapus	seperti	ini.	Apa	Kegunaannya:	Fill	Tool,	sebelumnya	adalah	alat	Paint	Bucket,
mengisi	setiap	area	padat	dengan	warna	pilihan	Anda.	Bersenang-senanglah	dengan	ini	dan	bereksperimenlah	pada	berbagai	lapisan,	gambar,	dan	teks.	Pilih	"Background	Eraser."	Sekarang	Anda	siap	melakukan	penghapusan	serius.	Selanjutnya,	seret	layer	atau	grup	ke	tombol	Create	a	New	Layer,	atau	klik	kanan	layer	untuk	memilih	"Duplicate
Layer"	atau	"Duplicate	Group."	Masukkan	nama	untuk	layer	atau	grup	baru,	dan	klik	OK.	Anda	juga	dapat	mengaksesnya	dengan	mengklik	"Layer"	di	bilah	menu	atas.	Brush	adalah	cara	yang	bagus	untuk	menambahkan	beberapa	aksen	visual	ke	konten	Anda.	Tip	Pro:	Anda	dapat	membuat	ukuran	kanvas	Anda	lebih	besar	dari	yang	seharusnya
sehingga	Anda	dapat	memberi	Anda	lebih	banyak	ruang	untuk	memindahkan	elemen	desain	Anda,	dan	memotongnya	ke	ukuran	yang	tepat	sesudahnya.	Pastikan	Anda	memiliki	layer	yang	ingin	Anda	pilih	sebelum	Anda	mulai	menghapus.	Untuk	mengedit	bagian	tertentu	dari	gambar	Anda,	Anda	harus	memilih	layer	tertentu.	Layer	adalah	elemen
Photoshop	yang	paling	penting	-	dan,	menurut	saya,	mereka	adalah	salah	satu	alasan	mengapa	banyak	orang	mengangkat	tangan	mereka	dengan	frustrasi.	Di	Mana	Letaknya:	Dari	menu	bar	bagian	atas,	pilih	Layer	>	Layer	Style	>	Blending	Options	...	Adobe	Photoshop	Express	is	the	mobile	version	of	Photoshop,	available	as	a	free	app	for	iOS	devices
and	Android	devices.	Adobe	Photoshop	CC	can	be	expensive	and	overwhelming	for	new	users.	Di	sini,	Anda	dapat	memilih	warna	solid	yang	ingin	Anda	isi.	Jangan	khawatir	tentang	memilih	warna	yang	Anda	inginkan	saat	itu	juga	-	cukup	beri	nama	layer	dan	tekan	"OK."	Selanjutnya,	Anda	akan	melihat	jendela	"Pattern	Fill"	muncul.	Warna	apa	pun
yang	Anda	buat	dapat	ditambahkan	ke	"Swatch"	jika	Anda	mengeklik	"Add	to	Swatch."	Kiat	Pro:	Ambil	warna	perusahaan	atau	warna	brand	Anda	dan	simpan	sebagai	"Swatch"	sehingga	Anda	dapat	mereferensikan	dan	menggunakannya	kembali	setiap	kali	Anda	mendesain	konten	visual	Anda.	Photoshop	was	first	invented	in	1987	by	two
brothers,	Thomas	and	John	Knoll,	who	sold	the	distribution	license	to	Adobe	in	1988.	Individual	users	may	prefer	the	Photography	package,	which	is	$9.99	per	month	and	includes	Photoshop,	Lightroom,	and	20	GB	of	storage.	It's	far	simpler	than	Photoshop	CC,	providing	a	basic	range	of	image-editing	functions,	such	as	contrast	and	exposure	tweaks
and	blemish	removal.	When	an	image	has	been	"photoshopped,"	it	has	the	connotation	of	being	manipulated	to	make	the	subject	look	better.	Brush	tool	sangat	cocok	untuk	menambahkan	aksen	desain	ke	konten-konten	Anda.	Apa	Kegunaannya:	Sama	seperti	font,	Anda	dapat	menambahkan	brush	khusus	Anda	yang	bebas	royalti.	Di	Mana	Letaknya:
Pada	bilah	menu	atas,	pilih	Layer	>	New	Fill	Layer.	Di	Mana	Letaknya:	Bilah	alat	di	sebelah	kiri,	di	bagian	atas.	Untuk	menyesuaikan	kotak	pangkas,	cukup	klik	dan	seret	kotak	jangkar	kecil	di	sisi	dan	sudut	kotak.	Kemudian,	cukup	klik	kanan	dan	putuskan	apa	yang	ingin	Anda	lakukan	dari	menu	yang	muncul.	Setelah	Anda	mengklik	ikon	alat	Teks,
semua	pengaturan	dan	opsi	font	akan	muncul	di	bagian	atas	layar	Anda.	Anda	dapat	memindahkan	banyak	objek	sekaligus	dengan	menyorot	beberapa	layer.	Apa	Kegunaannya:	Ketika	digunakan	dengan	benar,	alat	ini	akan	membiarkan	Anda	memilih	elemen	individu,	seluruh	grafik,	dan	menentukan	apa	yang	disalin,	dipotong,	dan	ditempelkan	ke
dalam	grafik	Anda.	Lightroom	was	designed	for	photographers	who	want	to	organize	and	lightly	manipulate	their	photo	collection.	It	is	considered	a	raster	graphics	editor,	which	means	users	can	create	and	edit	images	and	save	them	in	one	of	many	formats.	Ingat	untuk	memilih	layer	yang	ingin	Anda	hapus.	Untuk	memindahkan	semua	objek	dalam
satu	lapisan,	cukup	sorot	layer	dan	gunakan	Move	tool.	Perlu	diketahui	bahwa	jika	Anda	bekerja	dengan	anggaran	terbatas	dan	jadwal	yang	ketat,	Anda	dapat	menghemat	banyak	waktu	dan	uang	dengan	menggunakan	foto	stok	bebas	royalti.	Sesuaikan	ukuran	Background	Eraser,	dan	cukup	klik	warna	yang	ingin	Anda	hapus	dari	layer	yang	dipilih.
Mengubah	pengaturan	brush	dapat	memberikan	tampilan	dan	gaya	Anda	yang	sangat	berbeda.	Atau,	jika	Anda	sudah	memiliki	warna	tertentu	yang	Anda	tahu	nilai	heksinya	(contohnya	#	1fb1ee),	kemudian	masukkan	dalam	kotak	yang	sesuai	untuk	menemukan	warna	itu	secara	otomatis.	Karena	saya	memilih	lapisan	latar	belakang	untuk	diisi	(yaitu
warna	langit	dalam	grafik	saya),	warna	yang	saya	pilih	di	Color	Picker	menentukan	warna	langit:	Pola-pola	ini	dapat	dibuat	secara	manual	jika	Anda	memiliki	waktu	dan	kesabaran,	atau	Anda	dapat	menemukan	berbagai	pola	atau	patterns	bebas	royalti	yang	tersedia	untuk	diunduh	melalui	pencarian	Google.	Ini	berfungsi	seperti	alat	pemotong	apa
pun	yang	pernah	Anda	temui:	Cukup	pilih	area	Anda	dan	pangkas.	Di	Mana	Letaknya:	Toolbar	di	sebelah	kiri	Anda,	di	dekat	bagian	bawah.	Sorot	layer	objek	yang	ingin	Anda	pilih.	Dengan	pengaturan	brush,	Anda	dapat	mengubah	ukuran,	bentuk,	dan	transparansi	sapuan	brush	Anda	untuk	mencapai	sejumlah	efek	visual	yang	berbeda.	If	you	just	want
to	edit	a	photo	occasionally,	then	something	like	Photoshop	Elements	or	Photoshop	Express	will	be	more	than	enough	for	your	needs.		Photoshop	Elements	is	a	less	robust	version	of	Photoshop	CC.	Like	"Google"	and	"Xerox,"	the	term	"photoshop"	has	become	a	verb,	although	Adobe	discourages	this.	Menyimpannya	secara	teratur	akan	membantu
Anda	tetap	waras,	terutama	jika	Anda	menemukan	diri	Anda	mengerjakan	proyek	dengan	sejumlah	besar	layer.	Berikut	ini	lihat	apa	yang	ditawarkan:	Sebagai	contoh,	pada	gambar	di	bawah	ini,	saya	memilih	layer	teks	saya	dan	memilih	"Bevel	&	Emboss."	Terlihat	keren,	ya?	Dari	bilah	menu	atas,	pilih	Layer>	New>	Layer	...	Pro	Tip:	Selain	Photoshop
menawarkan	berbagai	macam	font,	Anda	juga	dapat	menginstal	font	Anda	sendiri	dengan	mengunduh	secara	gratis,	dan	kemudian	menginstal	font	baru	Anda	di	Photoshop	sehingga	Anda	bisa	menggunakannya.	Adobe	Photoshop	is	one	of	the	most	popular	and	well-known	photo-	and	graphics-editing	software	applications	around.	Misalnya,	Anda	dapat
menggunakan	efek	"Outer	Glow"	untuk	membuat	huruf	tampak	seperti	bercahaya.	Selamat	ber-photoshopping!	Ingin	mendapatkan	pemberitahuan	posting	terbaru	dari	blog	ini?	Hal	pertama	yang	harus	Anda	ketahui	adalah	itu	hanya	akan	berfungsi	jika	layer	disorot.	Setiap	lembar	dapat	dimodifikasi	secara	individual	tanpa	mempengaruhi	proyek
secara	keseluruhan,	yang	dapat	menghemat	banyak	waktu	saat	melakukan	pengeditan	untuk	masing-masing	elemen	grafik	Anda.	Karena	saya	telah	memilih	layer	latar	belakang	untuk	diisi	(yaitu	warna	langit	dalam	grafik	saya),	pola	yang	saya	pilih	dalam	Pola	Isi	mengubah	langit:	Untuk	menerapkan	gradien,	pertama	pilih	layer	yang	ingin	Anda	isi
dengan	pola.	Klik	ikon	"T"	di	bilah	sisi	kiri,	seret	kotak	teks	di	atas	area	tertentu	yang	Anda	inginkan	teksnya	muncul,	dan	Anda	siap	untuk	pergi.	Jangan	khawatir	tentang	memilih	warna	yang	Anda	inginkan	saat	itu	juga	-	cukup	beri	nama	layer	dan	tekan	"OK."	Selanjutnya,	jendela	Color	Picker	akan	muncul.	It	can	also	be	installed	on	the	Windows
desktop	with	Windows	8	and	above,	via	the	Microsoft	Store.	Luangkan	waktu	untuk	bermain-main	dengan	semua	efek	layer	dan	cari	tahu	mana	yang	menggelitik	kecintaan	Anda.	Anda	dapat	melihat	betapa	mudahnya	menghilangkan	warna	latar	belakang	dari	gambar.	Anda	dapat	memilih	warna	dari	koleksi	foto	Anda,	atau	menggunakan	warna
kustom.	Select	Tool	dikenal	sebagai	salah	satu	alat	paling	dasar,	namun	membuat	frustasi	untuk	digunakan	di	Photoshop.	Photoshop	has	many	automation	features	and	keyboard	shortcuts	that	help	you	save	time	on	repetitive	tasks.	Kemudian,	dari	bilah	menu	atas,	pilih	Layer	>	New	Fill	Layer	>	Gradient.	Juga,	Photoshop	menawarkan	sejumlah	cara
pintas	keyboard	yang	sangat	membantu	untuk	hal-hal	seperti	memperbesar	dan	memperkecil,	mengubah	ukuran	kanvas,	membuat	layer	baru,	dan	seterusnya.	Apa	Kegunaannya:	Alat	Crop	memungkinkan	Anda	memotong	gambar.	Alat	ini	adalah	keajaiban	yang	menghemat	waktu.	Di	Mana	Letaknya:	Layer	memiliki	modul	sendiri	di	sudut	kanan
bawah	layar	Photoshop	Anda,	secara	default.	Memilih	"Free	Transform"	untuk	skala,	memutar,	memindahkan,	dan	membalik	pilihan	Anda.	Dari	sana,	Anda	dapat	memilih	pola	dan	skalanya.	Saya	berharap	bahwa	saya	telah	memberi	Anda	pemahaman	yang	Anda	butuhkan	untuk	menggunakan	alat	yang	hebat	di	Photoshop	dengan	cara	yang	tepat
waktu,	efisien,	sehingga	Anda	dapat	meningkatkan	permainan	konten	visual	Anda,	seperti,	hari	ini.	Setelah	Anda	mengekstrak	warnanya,	Anda	akan	melihatnya	menunjukkan	keduanya	di	modul	Color	di	kanan	atas	layar	Anda,	serta	bagian	bawah	sidebar	kiri.	Edit	individual	images	or	large	batches	of	images	in	Photoshop.	Graphics	can	be	created	and
then	exported	to	other	programs.	Pilih	ikon	dari	sidebar.	Kiat	Pro:	Anda	dapat	melakukan	berbagai	hal	keren	dengan	lapisan	-	dan	percaya	atau	tidak,	membuat	animasi	GIF	adalah	salah	satunya.	Buka	gambar	yang	ingin	Anda	gunakan	di	Photoshop,	dan	gunakan	Select	Tool	untuk	menentukan	berapa	banyak	gambar	yang	ingin	Anda	salin.	If	you	don't
need	the	full	functionality	of	Photoshop	CC,	Photoshop	has	several	sister	applications	to	consider,	including	Photoshop	Elements,	Photoshop	Lightroom,	and	Photoshop	Express.	Atau	Anda	bisa	menggunakan	efek	"Drop	Shadow"	untuk	menambahkan	bayangan	ke	huruf	Anda.	Sekarang,	tidak	akan	realistis	untuk	menjamin	bahwa	Anda	akan	menjadi
ahli	Photoshop	pada	titik	ini	-	tetapi	bukan	itu	yang	dirancang	oleh	panduan	ini.	Tetapi	begitu	Anda	memahami	cara	kerjanya,	saya	berjanji	mereka	akan	membuat	hidup	Anda	lebih	mudah.	Setelah	Anda	memilih	area	gambar,	cukup	salin	area	tersebut.	Pro	Tips:	Selalu	beri	nama	layer	Anda.	Dengan	berbagai	pilihan	yang	tersedia,	Anda	dapat
mencapai	sejumlah	efek	yang	sangat	bagus	untuk	menyelesaikan	grafis	Anda.	The	software	is	used	for	editing,	creating,	and	retouching	images	as	well	as	adding	special	effects.	Seperti	kebanyakan	alat	di	Photoshop,	penghapus	hanya	berfungsi	pada	layer	yang	dipilih	secara	khusus.	Setelah	Anda	mengklik	ikon	Penghapus,	semua	pengaturan	akan
muncul	di	bagian	atas	layar	Anda.	A	Lightroom	subscription	is	$9.99	per	month;	it's	also	available	as	part	of	the	Adobe	Creative	Cloud	Photography	plan,	which	is	$9.99	per	month,	as	well.	Dari	sana,	Anda	akan	melihat	spektrum	warna	vertikal	dengan	slider	di	atasnya,	yang	dapat	Anda	sesuaikan	untuk	membuat	warna	kustom	Anda	sendiri.	Install
filters	and	plugins,	new	brushes	and	textures,	and	other	useful	extras	to	Photoshop	to	continually	boost	its	functionality.	Bermain-main	dengan	opsi	ini,	termasuk	gaya,	sudut,	dan	skala.	Anda	dapat	mengklik	dua	kali	kotak	warna	itu	untuk	memunculkan	pemilih	warna	lanjutan,	di	mana	Anda	kemudian	dapat	menyesuaikan	dan	menyimpan	warna	ke
swatch	untuk	penggunaan	di	masa	mendatang.	Photoshop	is	a	mainstay	for	designers,	web	developers,	photographers,	graphic	artists,	and	many	other	creative	professionals,	as	well	as	hobbyists.	Pengaturan	ini	memungkinkan	Anda	mengubah	ukuran	penghapus,	kekerasan,	dan	aspek	lain	dari	alat	ini.	Anda	juga	dapat	mengklik	kanan	objek	untuk
opsi	tambahan.	Try	Lightroom	for	free	for	seven	days	to	check	it	out.	Pastikan	untuk	memilih	lapisan	teks	yang	Anda	inginkan	untuk	mengeditnya.	Ini	juga	dapat	digunakan	untuk	menerapkan	pola	pada	gambar	Anda.	Di	Mana	Letaknya:	Di	bar	menu	atas,	pilih	View	>	Zoom	In	atau	View	>	Zoom	Out.	Layers	can	be	used	to	create	shadows	and	other
effects	and	can	act	as	filters	that	affect	underlying	colors.	Setelah	Anda	mengklik	ikon	Brush	Tool,	semua	pengaturan	dan	opsi	brush	akan	muncul	di	bagian	atas	layar	Anda.	Ini	berguna	ketika	Anda	mencoba	untuk	memposisikan	gambar,	teks,	dan	elemen	desain	lainnya.	Untuk	menggunakan	pintasan	keyboard,	tahan	ALT	(PC)	atau	Command	(Mac)
dan	tekan	+	untuk	memperbesar,	dan	ALT	(PC)	atau	Command	(Mac)	dan	tekan	-	untuk	memperkecil.	Apa	Kegunaannya:	Blending	Options	mencakup	sejumlah	fitur	untuk	meningkatkan	tampilan	atau	grafik	Anda.	Tapi	Photoshop	bukan	hanya	untuk	para	profesional.	The	product	was	originally	called	Display.	Selanjutnya,	cari	warna	yang	ingin	Anda
ekstrak,	dan	cukup	klik	area	itu	untuk	mengkloning	warna.	Klik	Ikon	Move	Tool	dari	bilah	menu	sebelah	kiri	dan	cukup	tarik	objek	yang	ingin	Anda	pindahkan.	With	Photoshop,	perform	simple	functions,	such	as	erasing	a	blemish	from	a	photo,	or	advanced	photo	editing	and	creation.	Pengaturan	ini	memungkinkan	Anda	mengubah	font,	ukuran	font,
dan	jarak	antar	karakter,	tinggi,	lebar,	warna,	dan	gaya.	Kemudian,	klik	kanan	pilihan	Anda,	dan	kemudian	Anda	memiliki	beberapa	opsi,	termasuk:	Memilih	"Layer	via	Copy"	untuk	menyalin	objek	dari	layer	ini	dan	membuat	layernya	sendiri.Kiat	Pro:	Untuk	memilih	seluruh	grafik	Anda	dan	menyertakan	semua	lapyer,	sorot	semua	lapyer	dan
kemudian	gunakan	Select	Tool.	Misalnya,	Anda	dapat	memotong	objek	dari	layer	saat	ini	dan	membuat	layer	Anda	sendiri.	Berikut	ini	saya	mencoba	memberikan	panduan	dan	tutorial	tentang	cara	menggunakan	Photoshop	untuk	pemula.	Baik	itu	cara	menggunakan	Photoshop	CS3,	cara	menggunakan	Photoshop	CS4,	cara	menggunakan	Photoshop
CS5,	cara	menggunakan	Photoshop	CS6,	dan	cara	menggunakan	Photoshop	CC.	Alat	Gradient	dalam	alat	Fill	memungkinkan	Anda	membuat	efek	latar	belakang	yang	bagus	dan	pudar	dari	warna	pilihan	Anda.	cukup	klik	link	subscribe	blog	Dafi	Deff	ini	(daftarkan	email	Anda)	maka	Anda	akan	mendapatkan	pemberitahuan	setiap	kali	blog	ini	di-update.
You	can't	doctor	images	like	you	can	with	Photoshop,	but	you	can	lighten	up	images	at	the	touch	of	a	button,	as	well	as	tweak	colors	and	enhance	or	sharpen	digital	photos.	Area	yang	disorot	ditandai	dengan	garis	putus-putus.	Penghapus	atau	Eraser	Tool	adalah	salah	satu	alat	paling	berguna	di	Photoshop.	Di	Mana	Letaknya:	Alat	Warna	&	Swatch
memiliki	modul	sendiri	di	sudut	kanan	atas	layar	Photoshop	Anda,	secara	default.	Jangan	takut	untuk	bermain-main	sedikit	dengan	semua	brush	kustom	Anda.	Anda	dapat	mengubah	ukuran	dan	kekerasan	ujung	penghapus	untuk	mencapai	berbagai	efek.	Ini	sangat	membantu	jika	Anda	membutuhkan	objek	dengan	latar	belakang	transparan.	Setelah
Anda	ingat	untuk	memperhatikan	layer	mana	yang	Anda	gunakan,	Select	Tool	menjadi	lebih	mudah	digunakan.	Kemudian,	dari	bilah	menu	atas,	pilih	Layer	>	New	Fill	Layer	>	Solid	Color	...	Anda	juga	akan	melihat	ada	simbol	"mata"	di	samping	setiap	layer:	Klik	simbol	itu	untuk	menyalakan	dan	mematikan	mata,	sehingga	mengubah	visibilitas	layer
saat	Anda	bekerja.	Ini	bagus	untuk	latar	belakang	yang	solid	atau	mewarnai	area	yang	luas.	Dari	sana,	jendela	"New	Layer"	akan	muncul	dan	meminta	Anda	untuk	memberi	nama	layer	pengisian	warna	baru.	Untuk	menerapkan	pola	atau	patterns,	pertama	pilih	layer	yang	ingin	Anda	isi	dengan	pola.	Untuk	menggunakan	Penghapus	Latar,	klik	dan
tahan	ikon	penghapus	sampai	menu	geser	muncul	keluar.	Gunakan	pintasan	CTRL	+	T	atau	Command	+	T	(untuk	Mac)	untuk	memulai	Free	Transform,	dan	periksa	opsi	yang	muncul	di	bagian	atas	layar	Anda.
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